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Getting started Guide

1. Introduction

On starting TSLOPE a five panel interface allows for a project directory tree (top left)
two analysis input panels (middle left) and a geometry panel (right) which provides
3D interactive graphics. The bottom left panel provides you with information on
TSLOPE processing activity.

The File tab enables a new project to be setup or an existing project to be opened.
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If starting a new project check each item in the directory tree panel. Beginning with
the first item - Title & Description. This is a useful place to document the location
and reason for the analysis especially if sharing with colleagues.

A small black command window will also open behind the main TSLOPE window.
That may show occasional error messages. Should you encounter a problem with
operation of TSLOPE and you need to share it with the TAGAsoft development team,
you should copy and paste the information in that window to an email message to
info@tagasoft.com
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TSLOPE
----- Title & Description
[ Preferences

‘E‘ Materials
L' Default
b Surfaces
...... Layers
...... Zones
Loads
..... Cross-sections
- Slope Cases
Bl Project
Units Metric

Weight of water (kN/m* 9.8
Atmospheric Pressure (k 101.3
B Graphics
Background colour l:l White
El Contours
Definition auto

Interval (m) 10
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2. Setup

In the preferences input panel (lower left) the
Units may be defined as metric, US Customary ,
or user defined by activating the tag on the right
side the Units cell. There is no automatic
conversion of values when the units label is
changed, but it is a reminder to the user to enter
appropriate values e.g. metric values will be kPa,
m, and kN/m? while U.S. Customary will be psf,
ft, pcf.

There are default values for the ‘Weight of water’
and ‘Atmospheric Pressure’. The unit weight of
water is required if a phreatic surface is defined
and the atmospheric pressure is required for the
curved Mohr-Coulomb failure criterion. Both
these values can be changed if required.

By default the background colour in the 3D
geometry panel is white but this can be changed
by left mouse clicking in colour cell to activate
the Color Chooser dialogue box.
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a- . TSLOPE
----- ) Title & Description
----- ) Preferences
‘l?.:, Materials
L' Default
b , Surfaces

..... . Cross-sections
|| Slope Cases

Bl Material 0
Id 0
Label Default

Mobr-Couomb |3

El Unit Weights
Unsaturated (kN/m®) 16
Saturated (kN/m®) 18
Bl Mohr-Coulomb

Cohesion function Constant

Cohesion (kPa) 0
Angle of friction (deg) 10

TSLOPE Getting started Guide

Proceeding down the directory tree the next part
of the setup involves defining the Material
properties.

Clicking on the Default tag shows the preset
values for slope stability analysis.

Clicking on the Label tag enables the material
name to be changed to the appropriate unit in the
slope model. Where there are different materials
in a slope model, the first material entered will
be the overlying material, or highest
stratigraphic unit.

The Failure criterion can be toggled between
Mohr-Coulomb or bedrock. Bedrock is a unit
that limits the extent of slope failure.

The unit weights for Dry and Saturated
scenarios can be adjusted.

Likewise the Mohr-Coulomb settings for
Cohesion and Angle of friction can also be
modified as required.

The material properties for other units in the
slope model are added by right mouse clicking
on the Materials tag and chosing Add material.
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a- |, TSLOPE
L Title & Deseription Up to three physical Surfaces may be modelled
B e for a slope stability problem, but the topographic

| i% Default and basal surfaces must be defined. The phreatic

L surface is optional.

- Zones
Loads
(- Cross-sections

To import the ground surface (topography)
right click the Top label in the Directory Tree
panel for the options :

- Slope Cases

Add Extruded section

Add Cloud of points (ASCII xyz)
Add Plane

Add Cone

Add Biplanar surface

Add surface file import (obj, dxf, vtp,
xml)

e Add Composite

Surfaces

The project Surfaces define the geometry
for one or more slope cases.

One top surface must be created before
any other data is added to the project. This
defines the extent of the current project; all

oher surfaces must overlap this top surface.

At least one basal surface (a possible
failure surface) must be defined before a
slope can be created. There is an
exception for 2D slopes for critical search;
a basal sphere will be automatically
created for this type of analysis.

The topographic surface is likely to have been
modelled in another software package. These
data may be contour or gridded values but require
XY Z components. If data import is via an
external file then use the Cloud of points or the
Surface file options. A file input dialogue box
will appear so the user can select the desired file.

It is recommended that you limit the area of the
surfaces that you import into TSLOPE to the area

of interest for your slope stability problem. The project dimensions are set to
accommodate the full range of X Y Z values that are loaded into the system.

Data imported are rendered using a Delaunay triangulation and displayed as a surface
in the Slope Geometry panel on the right side of the TSLOPE window.

When adding a surface as an Extruded section, (as in the case of an embankment),
you can manipulate the section plane by moving the purple nodes. The outer node
will lengthen/shorten the section, the middle node will rotate the section and the inner
node will move the section up/down. Once the plane is in the desired position it is
advisable to tick the check box for Is locked and assigned material properties for the
surface under the Material tab in the Data Panel (lower left).

The Plane and Cone derived surfaces are manipulated as for the Extruded section by
moving the coloured nodes to expand, rotate, and move the model into position.
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The Biplanar surface produces a hinged surface which can also be expanded by
manipulating the coloured nodes. The outer nodes control the size of the bi-plane
while the centre node raises and lowers the surface.

In addition to the nodes, the bi-planar surface dip and bearing direction can be
adjusted by changing the default values in the Data panel.

A Composite surface allows for combination of two or more surfaces, such as a
topographic surface, and a designed cut slope.

When the position of the surface is finalised click the Is locked tick box.

The surfaces can be removed at any time by highlighting the surface, then right mouse
click to select the Delete function.
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3D Geometry | Report Snapshots |
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X

592083767686

X=1767930.355, Y=5920109.278, Z=644.619

In the image above the directory tree is highlighted at
> Surfaces
> Top
> Topography (the icon on the left indicates import mode of the data)

In the data panel below is more information about the Top surface. The Label can be
renamed. The Is Locked tick ensures when rotating the model in the right panel the
geographic position remains fixed. The Colour can be reset by clicking the mouse
button on the 3-dot icon at the right and selecting from a separate colour chooser
panel or adjusting the numerical RGB components. The options for Surface
representation are: Flat, Gourand, Phong (which are all similar) and Wireframe.
Again a dropdown box of these options is available with a mouse click in the right
cell. The next two options in the data panel control the surface or contour
visualisation. These displays are controlled by toggling the tick icon.
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The Basal (failure) surface can be defined or imported in a similar manner to the Top
surface options. They include:

Add Extruded section

Add Cloud of points (ASCII X Y 2Z)
Add Plane

Add Ellipsoid

Add Log-Spiral

Add Parabaloid

Add Wedge

Add Surface file import

Add Composite

The Ellipsoid, Log Spiral and Parabaloid all follow the same methodology as for the
Extruded section. The choice of using one of these types of basal surface will depend
on the slope problem that is to be analysed.

In the case of the Basal wedge option the coloured nodes allow scaling of the wedge
and movement up and down, but the orientation of each side of the wedge is
controlled from the Data panel. This is so measurements taken in the field can be
applied. Separate material properties can be set for each side of the wedge.
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Waitemata Group || “ Project | 3 30 failure on modell... | 2/ 2D failure on modell... | 2 2D failure on beddin... | 3 3D failure on beddin...|

- Bedding plane

4 [ surf:

E] Basal Wedge -
Id 4
Label Basal Wedge 4
Type Wedge
Kind Basal Surface
B Geometry
Er—
B Toe point (m) (176748994603, 5920067
X 1767489.94603
v 592006726744
z -103.944173

Intersection line length | 361.259391
Intersection line heioht 1 101.538146 2

Extend plane 2
ove toe point
Hold <Ctl

> down to rotate wedge.

3D Geometry | Report Snapshots |

1

X=1767703.817, ¥=5920728.127, 7=286 918

A Composite surface allows for combination of two or more surfaces to form a basal
shear surface that will define a 3D potential failure volume.
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Phreatic surface/s can be added in a number ways. These include:

Add plane

Add Cloud of points
Add Extruded section
Add Surface file import
Add Biplanar surface

Geolmages

A Geolmage is an image (JPEG, PNG, TIFF), such as an aerial photograph, with
associated coordinate information that may be used to drape over a surface.
Boundary lines

A Boundary line is a 2D polyline that is associated with a top surface.

The boundary line may be a tension-crack line that has been observed in the field, and
may not be closed. For some slopes, movement may be sufficient to define a closed
boundary line that combines: a tension-crack, a side shear line, and a thrust line at the

base of the slope.

The use of a boundary line for a slope-case is optional.
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4. Layer datainput

[§ TSLOPE - karaka 2015:10-23 =2 WD |
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Layer Surfaces

A Layer surface allows material properties
to be defined as layered strata. The layer
surface defines the top of the extent of the
assigned material properties; the material
properties are assumed to be constant
below this layer surface, until another layer
surface is encountered.

The region above the highest layer surface
has the material properties as defined by
the ‘Default Material’.

Depending on the slope stability problem there are
options to refine the analysis by adding specific
Layers to the model that can have different
material properties.

For the definition of Layers TSLOPE works with
the top of each layer. We assume that the user
will have used a geological modelling system for
complex problems, and the appropriate checks
will have been made that there are no stratigraphic
anomalies.

TSLOPE assumes that the properties associated

with each layer extend with depth below the top

of each layer until the top of the next lower layer
IS reached.

To add a Layer right-click with the mouse to
reveal the options for importing a layer surface
Add Extruded Section

Add Cloud of points (ASCIl XYZ)
Add Surface file import

Add Plane

Add Composite

When adding a layer as an Extruded section, (as
in the case of an embankment), you can
manipulate the section plane by moving the purple
nodes. The outer node will lengthen/shorten the
section, the middle node will rotate the section

and the inner node will move the section up/down. Once the plane is in the desired
position it is advisable to tick the check box for Is locked and assigned material
properties for the surface under the Material tab in the Data Panel (lower left).
The material properties for the layer will apply to the area below the plane while
the area above the plane will adopt the overlying layer properties.
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5. Zones data input

[\ TSLOPE - karaka_201510-23.tsz——
— —

Fild), Edit View Help

& 00 DEd

; L080 modelled slide base -
4[5 Phreatic

L. groundwater
‘{—D Geolmages
I Geolmage 1
A-& Boundary lines
[ ‘" TensionCracklinel
a & Layers

! bedding plane

; Zones

4[5 Drillholes

{ LT 1:DHA1

T 2DH-2

Loads

AE.—_, Cross-sections
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w2 2D failure on bedding plane
.3 3D failure on bedding plane
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Zones

A Zone is defined by a horizontal
non-intersecting 20 polygon. The zone is
used to assign material properties for a 3D
volume as defined by the vertical extrusion
of this zone.

All columns that have their centres pass
through the zone are assigned the material
properties associated with that zone.

If there are any regions not covered by a
zone, the material properties will be that
given by the ‘Default Material’.

6. Loads

Under development.
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Zones may also be included in the model. To
activate the Zone input right mouse click on the
Zone label in the Directory tree and Add zone ...

In the data panel the Label can be renamed. The
points defining the zone can be initiated by clicking
in the Boundary points (m) cell which produces the
Zone Boundary Points dialogue box. Points can be
entered manually or imported via The File Import
option. The file is ASCII format (XY (ID is
optional)). Imported points will appear in the
dialogue box. Click OK to proceed.

The Colour, Opacity, and visibility parameters can
be set. Material properties for each zone can then be
defined under the Material tab in the Data panel box.

The height of the zone/s in the Slope Geometry
panel (right view) are controlled by the coloured
node which is visible when the Zones label in the
Directory panel is highlighted.



7. Cross-sections

TSLOPE also provides 2D slope analysis. To define a cross-section highlight Cross
section in the directory tree and right mouse click to Add section. To orient the
section through the model at the desired location move the end point nodes in the
Slope Geometry panel. One node acts as an anchor and the other changes the length
and orientation.

TSLOPE - karaka_2015-1
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File Edit View Help
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4 surfaces || "4 project | 3' 3D failure on modell... | 2 20 failure on modell... | 2 2D failure on beddin... | 3/ 3D failure on beddin...|
P

& Top

3' 3D failure on modelled slide base

Label Cross-sect tion 1
[False _______|
B Start point (m) (1767218327, 5919970.0%
X 1767218327
Y 591997009276
B End point (m) (176741780248, 5920125.71
X 176741780248
\ 592012571581
Bearing (deg.) 52040024
Length (m) 253.000002
B Visual Properties
Colour [ @02,161,236)
Opacity (0.100) 50
Show

1767680,9795

eading project in 5,619 sec
3D Geometry | Report Snapshots |

X=1767823.705, Y=5919550.772, Z=352.655
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8. Slope Analysis

A project may consist of one or more slopes. Multiple slopes allow parameteric
studies to investigate the stability of slopes when aspects of the slope vary, eg
material properties, pore pressure and phreatic surface changes, and any other
parameter of interest. Once the Material properties, Layers and Zones have been
defined and the Surfaces included the slope analyses can be conducted. Phreatic and
pore-pressure surfaces are optional.

To start a slope analysis, highlight the Slope Cases label in the directory tree and right
mouse button to add a new slope.

x| The Create New Slope dialogue box
B Slope 5 B provides the setup for the slope analysis

Label Slope 5 . . R

Descrption components. The Dimension is toggled to
o - be either 3D or 2D.

Top 6: topography

Basal 2: base of slide _:J

Phreatic None
Pore-pressure None

For 3D analysis the compulsory surfaces
are included from the Directory tree

- Surfaces for Top and Basal.

Phreatic surface or pore pressures can be
included.

Layer as basal Mone
B Loads
Load case None

K [ sowe

Slope | Description | Analysis

B Slope 3 -
Label Slope 3

Where the 2D option is selected the
menu automatically includes the
facility to select one of the pre-

1 S

Cross-section
H Surfaces

Top

Bazal

Phreatic

Use phreatic correction

Pore-pressure

Layer as basal

Clamp phreatic to top?

Clarnp z (m)
H Boundary line

Boundary line
— o |

1: Cross-section 1

1: topography
2: slide base
3: piezometric
False

Mone

Mone

Falze
0

Maone

m

defined cross sections and to specify
the number of slices that will be used
in the analysis. The larger the
number the longer the processing
time.

When the Slope Cases are active the
Data Panel (lower left view) has
two tabs: one has details about the
Slope (surfaces used) and the other
has the Analysis parameters. There
is also a Solve tab under the
Directory tree.

The 3D Slope Geometry panel (right view) now has a new tab for each slope case.
See Figure below. The gridded view of the model shows the columns involved in the
stability analysis in a darker shade.

TSLOPE Getting started Guide
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File Edit View Data Help
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aterials

| [ Project| 3 Stopel | 3 siope2| 2’ siope3

Slope | Description | Analysis

B Slope 1
Analysis type
Method

Materials definition | One material
El Tension Crack
TC definition None
E] 3D Column grid
Grid definition Num. columns/overall wic
No. columns/width | 200
Auto align grid False [~
Grid bearing (deg) 0
Column width (m) 75
B Advanced
‘Water weight (kN/m®) 9.8

Slope1 update finished

- | slope Geometry | Report Snapshots

1510 x 885 X=1767585.113, Y=5820299.466, 7-382579

The Analysis menu has default settings but each parameter has a number of options.

Analysis Type: Standard, Critical, Back Analysis, Solution-space analysis,
Yield acceleration analysis
Method: Spencer’s, Ordinary

Material Definition: One Material, Layers, Zones

If a layer or zone has been defined and is to be included in the slope case analysis then
the appropriate Material definition option needs to be selected in the Analysis Tab.

To commence the analysis for a particular slope case click on the Solve tab at the base
of the Directory tree panel (upper left). A new Results tab will appear in the data
panel (lower left). When any of the Material properties are changed then click the
Solve tab for an updated analysis.

9. Analysis Outputs

To view the various outputs select from the Data label in the upper left TSLOPE3
window. Outputs, which are only valid for the 3D cases, include:
e Total Normal Stress
Effective Normal Stress
Pore Pressure (where a Phreatic surface has been included)
Mobilised Shear Strength
OMC Local FS

TSLOPE Getting started Guide

12



All graphical results appear in the Slope Geometry panel on the right when the Data

type has been selected. In the case of a 3D analysis the Local Factors of Safety output
produces a colour-coded model based on the number of columns used for the analysis
and a directional vector with an overall FS value (see Figure below).

TSLOPE3 2.0.1 - C:\Program Files\ TAGAsoft', TSLOPE3' examples'karaka_jpciikaraka_2009.tsz
File Edit View Data Help
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[] Default
[ Layers
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C Zone 2
- Surfaces
= Top
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OMC Local Fs
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¥
[] Pore-pressure
#-[] Loads
#-[] Reinforcement
- Cross-sections
/" Cross-section 1
= Slope Cases i
7 1: Slope 1
7 z5wez -

Solve...

Slope: |Ana|ysis Results I

B Spencer's Results
Factor of Safety
Critical bearing (deq)
Equilibrium error (%)
Converged?
Beta (deqg)
Psi (deg)
Number of iterations
Number of columns
Sum Forces (%)
Sum moments (%)
Yolume (m=)
‘Weight (kN)
Surface areas (m2)
Ordinary Results
Factor of Safety
Critical bearing (deg)
Equilibrium error (%)
Number of columns
Sum Forces (%)
Sum moments (%)
Yolume (m?)
‘Weight (kN)
Surface areas (m?)

EE

o®

1.398

41.01

1.05 %

True

-19.1

-0.5

31

1068

-0.02; 0.08; 0
0.12; -0.04; -1.04
1.6086e+007
3.7836e+008
3.6901e+005; 3.7944e+009

1.332

39.0

1.63%

1068

-0.85; 0.1; -1.14

-0.64; -0.28; 0.36
1.6086e+007

3.7836e+008
3.6901e+005; 3.7944e+00g

-5.00

Slope Geometry | Report Snapshots |

1024 x 979

Each slope case can be selected from the TABs on the Slope Geometry panel or
from the Directory tree panel. Once a case has been solved the Local FS model
can be viewed by turning off the top and / or Phreatic surfaces from the View
menu. The coloured cells are mapped to the basal surface. The Results tab in the
Data panel itemises the key analysis parameters.

TSLOPE Getting started Guide
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In the case of a 2D slope analysis the cross section must have been selected for the
slope case. The bearing direction is calculated when the Cross section is defined
and can be found in the Data panel (lower left) when the Cross section is
highlighted in the Directory tree (upper left).

407

The graphical display of the 2D slope case shows the thrust line (red), the effective
normal stress (black arrow), and the basal pore pressure (blue arrows). These may be
toggled off, or on as required. If there are tensile interslice forces, then those slices
will be coloured red as a warning.

To interrogate the data graphically, position the mouse at a relevant point, and use
Cntrl left mouse click to get the display below. A further Cntrl left mouse click will
remove that information.

g
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10. Reporting

There are a number of features which enable the user to easily capture the graphical
outputs for inclusion in a report.

The background colours can be set and the image can be saved as a PNG by clicking
the ‘Save image to file’ tag from the TSLOPE window. The graphic can then be
inserted into other documents.

Next to the Save image to file tag is the ‘Take image for report’ tag. Whatever is
active in the Slope geometry panel will be saved into a Report snapshot tab that
appears at the bottom of that panel. Options are available to add a figure caption.

A summary report is automatically generated and can be previewed under
> File
> Print Preview Report

OR the Preview icon on the tool toolbar.

Any report snapshots associated with the slope cases will be included in the summary
report which lists all the surfaces and material properties as well as all the slope cases
analysed.

The TSLOPE3 summary report can be reproduced from the options under the File
toolbar
> File
> Print Report

or exported as a HTML file
>File
> Export
See Appendix 2.

The Data tab opens to allow selection of Save column data as CSV file...

Jata | Help

Measure distance |-

Save column data as C5V file .., h
Display thrust line
Display effective normal stress

Display basal pore pressure

RN

Display top water pressure

A CSV file will be opened in the current directory and allow the user access to all the
column (or slice) data.

TSLOPE Getting started Guide
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Appendix 1. Wedge and Tension Crack

This a theoretical example to demonstrate how to construct a bi-planar top surface and
a basal wedge with a tension crack and then analyse the slope stability of this model.

TSLOPE3 2.0.1 - C:\Program Files\TAGAsoft' TSLOPE3\examples\wedge_hoek_bray'\bi_planar_wedge_jpc.tsz 5 [u]
File Edit View Data Help

FlelB] ElEl [27C 27 (=]

i Tstoees Project |
[ Title & Description
£ Preferences
L] Materials
=B Surfaces
=B Top
top

& o
- Basal
 Bot
] Phreatic
[] Pore-pressure
@[] Loads
[ Reinforcement
[ Cross-sections
[ Slope Cases

El Bi-planar surface
Label top surface
Is locked
El Crest point
Location type Coordinate
Common point (m) {0.318745, -0.262266, -0.639
B Lower Plane
Dip (deq.) 65
Dip bearing {deg.) 185
Dip length (m) 180
Bl Upper Plane
Dip (deg.) 12
Dip bearing (deg.) 195
Dip length (m) 165
|2 size
Left width {m) 155
Right width {m) 155
B Surface style
Colour B (54,193,40)
Opacity 100
Surface representation  Phong
Show surface
Show contours

1184 x 918

The default material properties have been accepted and no layers or zones are used.

A Surface for the Top is defined by adding a bi-planar surface. The surface
automatically appears in the 3D geometry panel. The shape of the surface can be
manipulated using the coloured nodes which control the length and width of each
plane but these parameters can also be set manually in the data input panel on the
left. The Dip of each plane is set manually. In this case the parameters of the surface
have been adjusted to match the Heok and Bray example

Once the surface dimensions are finalised it is advisable to click the Is Locked box
before adding the Basal surface.

TSLOPE Getting started Guide
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The Basal surface in this theoretical example is a Wedge.

TSLOPE3 2.0.1 - C:\Program Files\TAGAsoft\ TSLOPE3\examples\wedge_hoek_bray'bi_planar_wedge_jpc.tsz =10(x]
File Edt View Data Help
fleld| Bl&l 7L 27 s
2 Tstoees Project |
[] Title & Description
£ Preferences
-F] Materials
=B Surfaces
] Pore-pressure
[ Loads
[ Reinforcement
[ Cross-sections
[ Slope Cases
B Basal Wedge -l
Label Bottom wedge
Is locked
Toe point (m) (55.0044, -61.6554, -94.92
Include tension crack pla False fod
Define planar materials? True
© Line of intersection
Intersection line length (1 245.875797
Intersection line height (1 127.357508
Trend (deg.) 157.732407
Plunge (deg.) 31.196514
© Plane 1
Label Plane 1
Dip (deg.) 45
Dip bearing (deg.) 105
Dip length (m) 121.759066
Uritt dry weight (kNjm?) 16
Urit sat. weight (kfm?) 18
Cohesion (kPa) 0
Angle of friction (deg) 10
B Plane 2
Label Plane 2
Dip (deg.) 70
Dip bearing (deg.) 235
Dip length (m) 100.641397
Unit dry weight (kN/m*) 16
Urit sat. weight (kifm?) 18
Cohesion (kPa) 0
Angle of friction (deg) 10
B Surface style
Colour B (222,112,83)
Opacity 100
Surface representation Phong
Show surface -
Show contours <1 | 30 Geometry [Report snapshots
1189 x 998 4

Like the bi-planar surface the wedge will automatically appear in the 3D Geometry
panel. The coloured nodes at the outer edges of the wedge control the width of each
side, the lower central node nodes raises or lower the wedge and the upper/rear central
node increases or decreases the length of the wedge axis.

The dip and dip bearing of each side of the wedge is set manually in the data input
panel. The other dimensions for each side of the wedge can also be set manually as
well as the material properties which are likely to vary from the default properties.

There is an option to add a tension crack to the wedge. At the top of the Data Input
panel the Include tension crack plane by default is set to false. To add a tension
crack toggle the false to true.

TSLOPE Getting started Guide
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As with the previous constructs of the model the tension crack will automatically
appear within the wedge when set to true.

TSLOPE3 2.0.1 - C:\Program Files\, TAGAsoft', TSLOPE3\examples\wedge_hoek_bray\bi_planar_wedge jpetsz
File Edit View Data Help

FleE] BE[[0C 27 L]

= [ TSLOPE3 o[ | Proiect | siope 1: slope 1 |

[ Title & Description

B Preferences

@[] Materials

- Surfaces

= Top
.

)
= Basal
W B
] Phreatic
] Pore-pressure
@[] Loads
£ Reinforcement
] Cross-sections
-8 Slope Cases

»| |«

Define planar materials? True

Bl Line of intersection
Intersection line length (I 245.875797
Intersection line height {1 127.357508

Trend (deg.) 157.732407

Plunge (deg.) 31.196514 >
fB Plane 1

Label Plane 1

Dip (deg.) 45

Dip bearing (deg.) 105

Dip length {ft) 121.759066

Unit dry weight (pcf) 160
Unit sat. weight (pcf) 160

Cohesion (psf) 500
Angle of friction (deg) 20
B Plane 2
Label Plane 2
Dip (deg.) 70
Dip bearing (deq.) 235
Dip length (ft) 100.641397

Unit dry weight (pcf) 160
Unit sat. weight (pcf) 160
Cohesion (psf) 1000
Angle of friction (deg) 30

B Tension Crack Plane
Label Tension-crack plane
Dip {deg.) 70

Dip bearing (deg.) 165
Distance from toe {ft) 100

B Surface style
Colour B (222,112,83)
Opacity 100
Surface representation  Phong
Show surface |
Show contours

v 3D Geometry |Report Snapshots

The tension crack has a node at the base of the wedge which moves the tension crack
plane forward or back within the wedge. The Dip and Dip bearing can only be
adjusted in the Data Input Panel.

Once the tension crack has been added the material properties may need revisiting.
In this case the Cohesion and Angle of friction for each side of the wedge have been
modified to reflect the Hoek and Bray example (1977 pg 334).

When all he surfaces and elements for the model have been defined it is time to build
a slope case.
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When adding a Slope Case the slope panel will adopt the Top and Basal surfaces that
have already been defined. If there is more than one top or basal surface then the user
will need to select the required ones. In the Data Panel under the Analysis tab there is
an option to increase or decrease the number of columns. Check the Advanced
parameter tag and tick the box to include partial columns if required.

Then SOLVE

TSLOPE3 2.0.1 - C:\Program Files\TAGAsoft\TSLOPE3\examples\wedge_hoek_bray'bi_planar_wedge_jpc.tsz

File Edit View Data Help
= 5 m
i [ [ =1 e s [
B [ TSLOPE3 Project Slope 1: Dry Slope with tersi..
[ Title & Description
E Preferences
#-[] Materials
-8 Surfaces
= Top
top surface

® ko
- Basal
W B

[] Phreatic
£ Pore-pressure
@-F] Loads
] Reinforcement
[ Cross-sections
=-f Slope Cases.
47 1: Dry Slope with tension crack

Solve...

Slope | Analysis Resu|t5|

B Spencer's Results
Factor of Safety 1.605
Critical bearing (deg)  167.39
Equilbriom error (%) 1.95%

Converged? True

Beta (deg) 10.9

Psi {deg) -10

Number of iterations 149

Number of columns 157
Sum forces (%) -1.82; -0.1; 0
Sum moments (%) 0.07; -0.69; 0.16

Yolume (Ft*) 88660

Weight (Ib) 1,4186e+007
Surface areas (ft2) 4924.5; 6453.3
B Ordinary Results

Factor of Safety 1.218
Critical bearing (deg) 1670
Equilbrium error (%) 52,98 %

Number of columns 157
Sum forces (%) -19.37; 12.28; -28.66
Sum moments (%) -23.49; -30.03; 2.4

Volume (ft?) 38660

Weight (Ib) 1,4186e+007
Surface areas (ft2) 4924.5; 6453.3

Slope Geometry | Report Snapshots

1 1 is | 1 Il

The 3D panel on the right now has a tab at the top for the new slope case. The Data
panel at the lower left now has a Results tab with includes both the Spencer’s and
Ordinary results.
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